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Creating an Accessible Word Document 
Microsoft Office has various tools available within Word, PowerPoint, Excel, Outlook, 
and Publisher to support users in creating documents that are accessible to all 
people. 

There are numerous resources with information for creating accessible documents. 
In some cases, organizations have a standard for how to accomplish certain tasks. 
This document includes the identified standard for the Michigan Department of 
Education, Office of Special Education (MDE, OSE). 

This document outlines the foundational steps to creating a Word document that is 
accessible to all users. Following these steps and practices will help to ensure your 
information is accessible. 

It is best practice to make a source document as accessible as possible before 
converting it to another format, such as an Adobe Acrobat PDF. 

Add Document Properties 
Document properties are an important component for search engine optimization 
and supporting accessibility. Document properties include information such as title, 
subject, author, keywords, and language. The information is used by search 
engines to return results for users searching for information. 

Document properties added in Microsoft Word will carry over in the conversion of a 
Word document to an Adobe Acrobat (PDF) document. 

A screen reader will convey the file name of a document to the user, so it is also 
important to use good naming conventions. Long or ambiguous file names can be 
confusing. 

OSE Standard 
There are several document properties, but the following fields are required to meet 
the OSE standard: 

• Title: The title of the document (must match the full title used in the main 
body of the document). 

• Subject: Brief identification of the topic of the document. 
• Author: List as MDE, Office of Special Education. 
• Keywords: Relevant keywords to help users find a document. Do not repeat 

the document title. Separate multiple keywords or phrases with a comma. 
• Language: The language the document was created in. 
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How to Add Document Properties 
To add document properties, click on the File tab in the menu bar. By default the 
Properties will display on the right side of the screen (Figure 1). If the properties 
are not visible, make sure that the Info option is selected from the sub-menu. 

To update the properties and set the language, perform the following steps: 

1. Open the Document Properties dialogue box by selecting the down arrow 
next to properties and choosing Advanced Properties. 

2. Select the Summary tab (Figure 2). 
3. Fill in the appropriate fields as outlined in the OSE Standard. 
4. Select the Custom tab (Figure 3). 
5. Select Language from the Name field drop down menu. 
6. Type the language (typically “English”) in the Value field. 
7. Click the Add button. 
8. Click OK to finish. 

 

Figure 1. Adding document properties 
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Figure 2. Summary tab in the document properties dialogue box. 

 

Figure 3. Custom tab in the document properties dialogue box. 
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Structure Content Using Appropriate Headings & Styles 
The use of built-in styles is the single most important step to making a document 
accessible. Headings and styles help to provide a structure and logical reading order 
and allow keyboard-only and assistive technology users to navigate content. 

Headings 
When headings are defined using Microsoft Word’s built-in heading styles, screen 
reader users can quickly navigate through the document and can easily skip from 
heading to heading. 

When headings are incorrectly marked up, using character formatting only (i.e., 
applying bold format, larger fonts, or using ALL CAPITAL LETTERS), there is no way 
for screen reader software to know where the headings are in the document. 

Heading Order and Heading Styles 
Headings should be applied to provide a sequential and relational understanding. 

Heading styles should be applied as follows: 

• Heading 1 – Title of the document. 
• Heading 2 – Major heading. 
• Heading 3 – Subheading. 
• Headings 4-9 – Sub-subheadings. 

Rules for Headings 
When using Heading styles adhere to the following rules: 

• The document title should be assigned a Heading 1. 
• There should only be one Heading 1 in each document. 
• Heading styles must be ordered correctly (i.e., Heading 4 is a child of 

Heading 3, not Heading 2). 
• Headings should be used to divide content into meaningful sections, not to 

format text. 

Title Style 
To allow for appropriate visual formatting, if a document includes a cover page, 
assign the Title Style to the document title on the cover page and a Heading 1 to 
the document title on the first page of the document content. 

Note: The Title Style is not recognized in Adobe Acrobat. After converting a 
Word document to a PDF, you must open the PDF in Adobe Acrobat and tag the 
document title on the cover page with a heading tag. 
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Columns 
Columns should be created using the Column Tool. Spaces and tabs should never 
be used to create the appearance of columns. If using the column feature, avoid 
using more than three columns. 

Lists 
When lists are formatted using the bulleted or numbered lists functions, screen 
readers will properly announce the text as being part of a list. List formatting 
provides the user with a means to easily navigate between items as well as skip 
them. 

When lists are made with repeated use of the tab key or spacebar, screen readers 
will not recognize them as lists, meaning that the list reading controls are 
inoperative. 

In general, plain bullets and numbers are more accessible than graphical bullets 
and numbers. Do not use the Wingdings font or manually typed characters (e.g., 
hyphens, asterisks, numbers, or graphics). 

Sub-lists should be created by using the increase indent function. 

How to Use Styles 
By default, a small number of styles are visible from the Quick Styles gallery in 
the menu bar (Figure 4). 

 

Figure 4. Quick styles gallery. 

Opening the Styles Task Pane 
Users may find it beneficial to open the Styles Task pane (Figure 5) to see more 
styles as well as other options. The styles task pane also shows a preview of each 
style. To open the styles task pane, perform one of the following steps: 

• Click on the expand icon in the bottom right corner of the styles group 
(Figure 6). 

• Use the keyboard shortcut CTRL+ALT+SHIFT+S. 

Predefined Styles 
Word has a number of predefined styles, including styles for headings, normal text, 
emphasis, lists, and bold. Users can modify the predefined styles or create their 
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own. However, it is important to note that JAWS (the most popular screen reader 
software) does not recognize custom named styles. Therefore, it is best to 
customize Word’s predefined styles instead of creating your own. 

 

Figure 5. Styles task pane. 

 

Figure 6. Icon to expand styles task pane. 
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Types of Styles 
There are three different types of styles in Word: 

1. Paragraph styles 
2. Character styles 
3. Linked styles 

Each style type is depicted by an icon (Figure 7) in the styles task pane. 

 

Figure 7. Style type icons. 

Paragraph styles include the font, font type, and size as well as formatting 
elements for a whole paragraph’s text positioning and spacing. A paragraph style 
can be applied to one or more paragraphs. 

A paragraph style’s formatting will be applied to all the text within the paragraph 
where your cursor is located. 

Character styles are applied at the character level; to blocks of words or letters. 
You can apply character styles along with a paragraph style. For example, all text in 
this document has the paragraph style Normal applied to it. The word normal in 
previous sentence also has the character style Strong applied to convey 
importance. 

Linked styles can function as either a paragraph style or a character style, 
depending on what you select. If you select a word or phrase in a paragraph and 
apply a linked style, the style is applied as a character style, with no effect on the 
paragraph as a whole. However, if you select a paragraph and then apply a linked 
style, the style is applied as a paragraph style. 

Note: Word includes character styles called strong and emphasis to help convey 
meaning to a screen reader. When you need to apply bold and italics, it is best 
practice to apply the strong and emphasis style. 
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Applying a Style 
To add a paragraph style, put your cursor anywhere within the paragraph or line 
and then select the desired style from the Quick Styles gallery (Figure 4) or the 
Styles Task pane (Figure 5). 

To add a character style, highlight the appropriate text and then select the style 
from the quick styles gallery or the styles task pane. 

Modifying a Style 
The characteristics of any predefined style can be modified. This includes 
everything from font type and size to alignment, spacing, and indentation, to 
borders and tabs. To modify an existing style, perform the following steps: 

1. From the Quick Styles gallery (Figure 4), right click the applicable style and 
select Modify. Or, from the Styles Task pane (Figure 8), select the down 
arrow to the right of the applicable style and select Modify. 

2. Make the appropriate changes in the Modify Styles Dialogue Box (Figure 
9). 

3. Select the Format option within the dialogue box for more options. 

 

Figure 8. Modify a style. 
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Figure 9. Modify style dialogue box. 

White Space and Borders 
White space in a document should be controlled using the styles in the document. 

The “Enter” key should never be used to create white space within a document 
(e.g., spaces between paragraphs or pushing content to the following page). 
Spaces and empty paragraphs may be perceived as blanks by people using a screen 
reader and can cause a user to assume they have reached the end of the 
information. 

Borders should be added using styles versus text boxes or tables. 

Note: Text boxes are not accessible and should never be used. Instead, use the 
border function to highlight or call out text. 

OSE Standard 
Adhere to the following minimums when setting line and paragraph spacing: 

• Line spacing: 1.08 
• Spacing after the paragraph: 6 pts. 
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How to Adjust Spacing 
To modify the line spacing and spacing between paragraphs, perform the following 
steps: 

1. From the Quick Styles gallery (Figure 4), right click the applicable style and 
select Modify. Or, from the Styles Task pane (Figure 8), select the down 
arrow to the right of the applicable style and select Modify. 

2. Click the Format drop down button and select Paragraph (Figure 10). 
3. Adjust the line spacing and spacing before and after the paragraph in the 

Paragraph dialogue box (Figure 11). 
4. Click OK twice to finish. 

 

Figure 10. Select paragraph settings. 
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Figure 11. Paragraph spacing options. 

Normal Style and Body Text Style 
The text of a document is automatically formatted with the Normal style. Normal is 
the style on which almost all other styles (unless you change this) are based. 

If you change the font or paragraph formatting of the Normal style, it will have a 
ripple effect throughout most of the other document styles. 

Body Text is a style intended for the ordinary text of the body of a document. By 
default, it is identical to the Normal style except that it has an additional half line 
of spacing between paragraphs. Use of the Body Text style is optional. 

As a reminder, line spacing and spacing between paragraphs should be controlled 
using styles and not be adding extra returns. 

How to Make a Style Permanent for New Documents 
All styles can be modified to incorporate the desired font type, size, and spacing 
options. If you use similar formatting options in most documents, the style can be 
set as a default for future documents. 
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To set a style as the default for new documents, perform the following steps (Figure 
12): 

1. From the Styles pane, select the appropriate style. 
2. From the Menu bar, select the down arrow next to Change Styles. 
3. Click Set as Default. 

 

Figure 12. Set style as a default. 

Include a Table of Contents and Cover Page 
Provide a table of contents and cover page for documents that are more than eight 
pages. Microsoft Word can create a table of contents from the heading structure. 

How to Add a Table of Contents 
To add a table of contents, go to the page where the table of contents should be 
added and perform the following steps: 

1. Select References from the menu bar. 
2. Select the down arrow next to Table of Contents. 
3. Select the desired style and the table of contents will automatically populate. 
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As more information is added to the document, the table of contents can be 
updated to reflect the changes by performing the following steps: 

1. Click on the table of contents to reveal the available options. 
2. Select the Update Table (Figure 13) option at the top of the table of 

contents. 
3. Select update page numbers only or update entire table from the Update 

Table of Contents dialogue box. 
4. Click OK to finish. 

 

Figure 13. Update table of contents options. 

OSE Standard 
If a document includes a table of contents, a cover page should be added to the 
document. The cover page must include the following components: 

• Document title 
• Date of document 
• Name of office (Michigan Department of Education, Office of Special 

Education) 
• MDE logo 
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Avoid Putting Vital Information in Headers & Footers 
Screen readers do not automatically read the information contained in headers, 
footers, and watermarks. Vital information such as the document title, author or 
contact information, and date of the document or document version number must 
be duplicated at or near the start of the main content area or on a cover page. 

It is acceptable to put running headers, logos, page numbers, and copyright 
messages in the header or footer. 

Provide Alternative Text for Images, Graphs, & Figures 
Users who are blind or have low vision need an alternative way to understand 
information represented by images, tables, diagrams, and other visual mediums. 
Alternative text provides a text-based representation of information contained in 
items that cannot be seen. 

Images 
Alternative text for images should: 

• Be accurate. 
• Be concise. 
• Convey in words—as briefly as possible—the same information that is 

communicated by the image. 
• Represent the purpose and function of the image, not just describe its 

appearance. 
• Exclude the phrases “image of” or “graphic of.” 

Note: Alternative text cannot be read by screen readers in the same way as 
regular text. The screen reader will read all of the alternative text or none of it. 
Users can’t explore it or read it character by character or word by word. Ensuring 
that alternative text is concise and meaningful supports users understanding of 
an image or object. 

Adding Alternative Text 
When adding alternative text in Word, a dialogue box will open with two fields: Title 
and Description. 

The title can be read to a person using a screen reader and is used to determine 
whether he or she wishes to hear the description of the item. The main information 
about the image should be added to the description field. 
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Some resources indicate the title field should only be used if the description is 
lengthy and other sources say to always leave it blank. In general, the title field is 
optional and the description field is required. 

Decorative Images 
In general, decorative images do not need alternative text. However, when the 
accessibility checker (see page 26) is run, an error will be generated in the checker. 
Consider the need or purpose before adding decorative images. 

Adobe Acrobat allows a decorative image to be marked as a background element. 
Items marked as background elements will be ignored by assistive technology. 
Microsoft Word does not have a function to mark images as decorative. 

OSE Standard 
In Microsoft Word, do not add alternative text to decorative images. However, once 
the document is converted to a PDF, the image must be tagged as a background 
element so the image isn’t read by a screen reader. 

How to Add Alternative Text 
To add alternative text, perform the following steps: 

1. Right-click on the image. 
2. Select Format Picture. 
3. Select Alt Text in the Format Picture dialogue box (Figure 14). 
4. Type the description of the image in the Description field. 
5. Click OK to finish. 

 

Figure 14. Alternative text description field. 
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Use and Create Tables Appropriately 
Tables should be used only to convey information and not for layout purposes. 
Tables used for formatting purposes are confusing and often impossible for users of 
assistive technologies to access. 

Tables should be created using the table tool and not drawn. This will provide the 
proper structure. To maintain structure, avoid: 

• Merging cells. 
• Splitting cells after data has been entered. 
• Using blank cells to format the table. 

All tables must have a header row identified and set to repeat at the top of each 
page regardless of whether the table spans multiple pages. Heading styles should 
never be used in a table. 

The formatting for a table should be controlled using the table properties. 

How to Create a Table 
To create a simple table, perform the following steps: 

1. Select the Insert tab from the menu bar. 
2. Select the Table menu. 
3. Select the number of rows and columns (Figure 15) by either, a) using the 

cursor to select the number of columns and rows from the grid or b) by 
clicking on the Insert Table option and inputting the number of columns and 
rows in the Insert Table dialogue box (Figure 16). 

 

Figure 15. Insert table options. 
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Figure 16. Insert table dialogue box. 

After a table has been created and populated with data, identify a Header Row to 
allow the heading text to be distinguished from the data portion of the table. 
Identifying a header row is also important if a table spans more than one page. 

To identify a Header Row, perform the following steps: 

1. Highlight the top row of the table (Figure 17). 
2. Right click to display editing options. 
3. Select Table Properties from the list. 
4. In the Table Properties dialogue box (Figure 18), select the Row tab. 
5. Check the option Repeat as header at the top of each page. 
6. Click OK to finish. 
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Figure 17. Table properties menu. 

 

Figure 18. Table properties dialogue box. 
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Create Meaningful Hyperlinks 
Hyperlink text should provide a clear description of the link destination. Users of 
assistive technology can navigate a document by skipping from hyperlink to 
hyperlink, or by pulling up a list of all links in a document. Neither method includes 
any of the surrounding text, meaning the hyperlink text itself must be descriptive to 
provide sufficient meaning. 

A non-descriptive link such as ‘Click here’ or ‘more’ does not provide enough 
meaning. In addition, listing the full URL instead of descriptive text can be tedious 
for users of screen reader software because the screen reader will read each 
individual character/word in the hyperlink. 

To avoid confusion, it is important that links to the same destination have the same 
descriptive text. 

Example Hyperlinks 

• Descriptive hyperlink: OSE website 
• Non-descriptive hyperlink: http://www.michigan.gov/ose-eis 

Note: The non-descriptive link in the example above will cause this document to 
generate a warning for unclear hyperlink text when the accessibility checker is 
run. The non-descriptive hyperlink text is included for demonstration only. 

Email Links 
Email addresses can be presented as either descriptive or as the actual email 
address. If the actual email address is used, consider adding a screen tip. 

Example Email Links 

• Descriptive email link: Email the OSE helpline 
• Non-descriptive email link: Email the OSE helpline at mde-ose@michigan.gov 

Digital and Print Documents 
When information is intended for use in both digital and print format and contains a 
hyperlink, the URL or email address should be included after the descriptive 
hyperlink text. 

Use the following format for adding descriptive hyperlink text along with the URL: 

• OSE website (http://www.michigan.gov/ose-eis) 

http://www.michigan.gov/ose-eis
http://www.michigan.gov/ose-eis
mailto:mde-ose@michigan.gov
mailto:mde-ose@michigan.gov
http://www.michigan.gov/ose-eis


Creating an Accessible Word Document Page 23 of 29 

Note: If the full URL in the above example is an active link, the accessibility 
checker will return a warning that unclear hyperlink text is present. To avoid the 
warning, it is best practice to include the full URL as text and not an active link. 

How to Add a Hyperlink 
To insert a hyperlink, perform the following steps: 

1. Highlight the text that will become the active link or insert your cursor in the 
location where the hyperlink will be added. 

2. Select the Insert tab from the menu bar. 
3. Select Hyperlink from the menu options (Figure 19). 
4. Select Existing File or Web Page under Link To. 
5. Confirm the appropriate text is displayed in the Text to Display field. 
6. Type the full URL in the Address field (http://www.sample.com). 
7. Click OK to finish. 

 

Figure 19. Insert hyperlink menu. 
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How to Add an Email Link 
To insert an email link, perform the following steps: 

1. Highlight the text that will become the email link or insert your cursor in the 
location where the email link will be added. 

2. Select the Insert tab from the menu bar. 
3. Select Hyperlink from the menu options (Figure 20). 
4. Select Email Address under Link To. 
5. Confirm the appropriate text is displayed in the Text to Display field. 
6. Type the email address in the Email Address field. 
7. Click OK to finish. 

 

Figure 20. Insert email address menu.  
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Use Appropriate Fonts, Colors, & Contrast 
Using an appropriate font and ensuring good color contrast are important when 
developing a document. 

Sans serif fonts are generally recommended for their readability, ability for users to 
discern, and ability to be clearly magnified. Popular sans serif fonts include Arial, 
Calibri, Geneva, Helvetica, Tahoma, and Verdana. 

Users with low vision and color blindness may have difficulty reading documents 
that do not present sufficient contrast and color difference between the background 
and foreground elements. Dark colors on a white background work best. Test color 
contrast by printing or viewing the document in grayscale. There are also a number 
of online tools for checking document contrast. 

Use color only as an enhancement and not as the sole means of conveying 
information. If you want to use color to emphasize the importance of certain text, 
also use an alternative method; do not use color alone. 

OSE Standard 
The Michigan Department of Education standard font and size is Verdana, 11 point. 

Check the Accessibility of the Document 
Microsoft Word 2010 and later has a built-in accessibility checker. The checker 
provides information on issues within the document that should be reviewed and 
addressed. Prior to distributing a document or converting it to a PDF, run the 
accessibility checker to ensure the document does not have any errors or warnings. 

The accessibility checker will not flag all issues, so it is important to understand the 
appropriate way to create a document. For example, the checker will not provide an 
alert if character formatting was used to create bold text instead of applying the 
character style of strong (see character styles on page 10). 

The checker provides three levels of alerts: 

1. Errors – Content that makes a document difficult or impossible for people 
with disabilities to understand. Errors MUST be corrected. 

2. Warnings – Content, that in most, but not all, cases makes a document 
difficult for people with disabilities to understand. Warnings should be looked 
at and addressed, if possible. 

3. Tips – Content that people with disabilities can understand, but that might 
be better organized or presented in a way that would improve their 
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experience. Tips should be reviewed to determine if the information can be 
presented in another manner. 

Note: It is best practice to make the source document as accessible as possible 
before converting it to another format, such as Adobe Acrobat PDF. 

How to Run the Accessibility Checker 
To run the accessibility checker, perform the following steps: 

1. Select the File tab from the menu bar. 
2. Select Check for Issues under the Prepare for Sharing heading and 

choose, Check Accessibility (Figure 21). 

The results of the accessibility checker will display in a new pane on the right side 
of the screen (Figure 22). 

Selecting any of the errors, warnings, or tips will take you to the location in the 
document where the issue exists. After fixing an issue it will disappear from the list 
of results. Selecting an issue from the accessibility checker pane will also display 
additional information about why the issue should be fixed and how to fix it. 

 

Figure 21. Check accessibility menu. 
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Figure 22. Accessibility checker inspection results. 

Create a PDF 
There is more than one way to create a PDF from a Word document, but setting the 
appropriate options is essential to achieving the best result. An accessible PDF 
document is often called a Tagged PDF because it includes Tags that encode 
structural information required for accessibility. 

How to Create a PDF 
If you have the full version of Adobe Acrobat installed on your computer, an 
Acrobat tab (Figure 23) will be visible on the menu ribbon. This Adobe Acrobat add-
in produces a better tagged and accessible PDF. 

 

Figure 23. Acrobat menu tab. 
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To create a PDF from the Acrobat add-in, perform the following steps: 

1. Select the Acrobat tab from the menu bar. 
2. Select the Preferences option. 
3. Review the Application Settings in the Acrobat PDF Maker dialogue box 

(Figure 24) and make sure there is a check mark next to the following 
options: 

4. Create bookmarks 
5. Add links 
6. Enable accessibility and reflow with tagged Adobe PDF 
7. Click OK. 
8. From the Acrobat tab, select Create PDF. 
9. Choose the location where the file should be saved. 
10.Click Save to finish. 

 

Figure 24. Acrobat PDF Maker dialogue box. 
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To create a PDF from the Word add-in, perform the following steps: 

1. Select the File tab from the menu bar. 
2. Select Save As. 
3. Choose the location where the file should be saved. 
4. Click the drop-down arrow for the Save as Type and select PDF. 
5. Click the Options button. 
6. Check Create bookmarks using and select the radio button next to 

Headings (Figure 25). NOTE: This option will be grayed out if no headings 
are present in the document. 

7. Check Document structure tags for accessibility 
8. Click OK. 
9. Click Save to finish. 

 

Figure 25. Acrobat PDF options. 

Note: Even a PDF that has been created from an accessible Word document will 
almost always have accessibility issues. As a result, the PDF will require further 
remediation so that it is accessible. 
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